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Important information

PN WARNING

« Failure to follow the installation instructions shipped with your SMART product could result in
personal injury and product damage which may not be covered by your warranty.

o Do not open or disassemble the SMART product. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids your warranty.

« Do not stand (or allow children to stand) on a chair to touch the surface of your SMART
product. Rather, mount the product at the appropriate height.

o To reduce the risk of fire or electric shock, do not expose the SMART product to rain or
moisture.

o Ifyour SMART product requires replacement parts, make sure the service technician uses
replacement parts specified by SMART Technologies or parts with the same characteristics
as the original.

« Ensure that any cables extending across the floor to your SMART product are properly
bundled and marked to avoid a trip hazard.

« Do notinsert objects inside the cabinet ventilation holes, because they could touch
dangerous voltage points and cause electric shock, fire or product damage which may not
be covered by your warranty.

« Do not place any heavy objects on the power cable. Damage to the cable could cause
shock, fire or product damage which may not be covered by your warranty.

« Use only extension cords and outlets into which this product’s polarized plug can be fully
inserted.

« Use the power cable provided with this product. If a power cable is not supplied with this
product, please contact your supplier. Use only power cables that match the AC voltage of
the power outlet and that comply with your country’s safety standards.

o Ifthe glassis broken, do not touch the liquid crystal. To prevent injury, handle glass
fragments with care when disposing of them.

« Do not move or mount the interactive flat panel by connecting rope or wire to its handles.
Because the interactive flat panel is heavy, rope, wire or handle failure could lead to
personal injury.
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IMPORTANT INFORMATION

o Use only VESA®-approved mounting hardware.

« Disconnect all power cables for your interactive flat panel from the wall outlet and seek

assistance from qualified service personnel when any of the following occurs:
o The power cable or plug is damaged
o Liquid is spilled into the interactive flat panel
o Objects fall into the interactive flat panel
o The interactive flat panel is dropped
o Structural damage such as cracking occurs

o The interactive flat panel behaves unexpectedly when you follow operating
instructions

' cauTtioN

« Before you clean your SMART product, shut down or disconnect the computer. Otherwise,

you may scramble the desktop icons or inadvertently activate applications when you wipe
the screen.

Avoid setting up and using the SMART product in an area with excessive levels of dust,
humidity and smoke.

Make sure an electrical socket is near your SMART product and remains easily accessible
during use.

The external power supply needs to meet the Limited Power Source (LPS) requirements of
CSA/UL/IEC/EN 60950-1, when required.

This SMART product should be used only with European TN and TT power distribution
systems.

It is not suitable for older, IT-type power distribution systems found in some European
countries. "This system (IT-type) is widely used isolated from earth, in some installations in
France, with impedance to earth, at 230/400V, and in Norway, with voltage limiter, neutral
not distributed, at 230V line-to-line." (IEC 60950:1999)

Contact qualified personnel if you're uncertain of the type of power system available where
you’re installing your SMART product.

You must connect the USB cable that came with your interactive flat panel to a computer
that has a USB compliant interface and that bears the USB logo. In addition, the USB source
computer must be compliant with CSA/UL/EN 60950 and bear the CE mark and CSA and/or
UL Mark(s) for CSA/UL 60950. This is for operating safety and to avoid damage to the
interactive flat panel.
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IMPORTANT INFORMATION

IMPORTANT

« The following are the power requirements for your interactive flat panel:

Model Power requirements

SPNL-6065 100V to 240V AC, 50 Hz to 60 Hz, 190 W

« Foradditional requirements and other information, refer to your interactive flat panel’s
specifications (see Specifications on page 7).
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Chapter 1

Welcome

About your interactive flat panel

FEatUNE S

Components
Front view

o (==Y o 1
Cameras and reflective tape channel
SR EAKEIS il
Pens and erasers
Front control panel
ADOUL this QUIE ... e
Other documentation and resources

Specifications

Installation instructions

Training

Knowledge base

This chapterintroduces you to your SMART Board interactive flat panel and this guide.

About your interactive flat panel

Your SMART Board® interactive flat panel features SMART’s proprietary DViT®

(Digital Vision Touch) technology on an LCD screen with e-LED backlight which enables you to
select, write and erase on the interactive surface. You can do everything on the interactive flat
panel that you can do at your computer by touching the surface, and you can use an array of
gestures within applications.
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CHAPTER1
WELCOME

Features
Your interactive flat panel includes several features:

« Touch-enabled interactivity and object awareness
« Multitouch capabilities
o Gesture support
e PenlID
« Pens
o Multiuser support
« Audio
« SMART software
Touch-enabled interactivity
You can do everything on your interactive flat panel that you can do at your computer—open and

close applications, meet with others, create new documents or edit existing ones, visit websites,
play and manipulate videos and so on—by touching the interactive surface.

You can also write over any application in digital ink using one of the supplied pens or your finger,
and then erase the digital ink using the eraser on the pen or your palm.

Object awareness enables you to pick up a pen, and then write, select or erase without replacing
the pen.

Multitouch capabilities

Support for a minimum of four simultaneous touches enables multiple users to interact with the
interactive flat panel by using the included pens or other objects, or by using their fingers to write
and to perform gestures.

Gesture support
You can use an array of gestures within applications, including panning, scaling, rotating and
zooming in and out.

Pen ID
The Pen ID feature enables you to assign different ink appearances to each pen.

Pens
The interactive flat panel includes two pens with attached erasers.
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Multiuser support
Two users can each pick up pens and draw on the screen at the same time, enabling greater
collaboration.

Audio
Your interactive flat panel includes two 10 W integrated side-firing speakers for presenting audio
from connected input sources.

SMART software
You can install the following SMART software on the computers connected to your interactive flat
panel to take full advantage of the interactive flat panel’s features:

Software Description

SMART Product Drivers SMART Product Drivers enables connected computers to detect
input from your interactive flat panel.

SMART Ink® SMART Ink enables you to write and draw in digital ink over open
applications, files, folders, websites and any other open window on
your computer. When you write outside the open windows on your
computer, a SMART Ink Note appears and you can write inside the
note.

When you open an application that has its own ink tools, you can

turn off SMART Ink, and then use the application’s ink tools to write
inthe content.

SMART Notebook® SMART Notebook software enables you to use your interactive flat
collaborative learning panelin a classroom.
software
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Components

Front view
Your interactive flat panel consists of the following components:

SMART.
{—p
2
[ = I e e ] [ — )
o ! ]
| | |
3 4 4
No. Name
1 Cameras and reflective tape channel
2 Screen
3 Front control panel
4 Pen
NOTE

Components not pictured include the connector panels (see Connector panels on page 13) and
the menu control panel (see Menu control panel on page 21).

Screen
Models Diagonal Width Height Aspect ratio
SPNL-6065 641/2" (163.9cm) 561/4"(142.8cm) 315/8"(80.4cm) 16:9

For information on cleaning the screen, see Cleaning the screen on page 26.
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Cameras and reflective tape channel
In the corners of the screen, there are cameras that track finger and pen positions across the
screen. The screenis bordered by a channel that contains reflective tape.

For information on cleaning the camera windows and reflective tape, see Cleaning the screen on
page 26.

'\ cauTioN
« Keep the reflective tape dry.

« Do notremove or damage the reflective tape.

IMPORTANT

« Do not attach items such as adhesive notes to the screen because they will interfere with
the cameras.

« Do not place anything in the channel because it will interfere with the cameras.

Speakers
Your interactive flat panel includes two 10 W integrated front firing speakers. You can connect
external speakers if desired (see Connecting external speakers on page 15).

Pens and erasers
Your interactive flat panel comes with two pens with an eraser attached.

The bottom bezel of the interactive flat panel includes magnetic holders for the pens. Removing a
pen from the holders activates it and enables you to either draw or erase digital ink.

' cauTtioN

When returning the pen to the magnetic holder, ensure that it is centered in its holder to prevent
it from falling and potentially being damaged.
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Front control panel

The front control panel contains the Standby, Input Select, Mute and volume control buttons.

1 2

2] ®

3 4 5
| | [

w <L =

IMPORTANT

No. Name

1 Standby button

2 Input Select button
3 Mute button

4 Volume decrease
5 Volume increase

o Ifthere is a film over the front control panel, remove the film before using the front control

panel.

In normal use:

« The volume control, Mute and input buttons are white.

« The Standby button is white when the interactive flat panelis on

« The Standby button is amber when the interactive flat panel is in standby

About this guide

This guide explains how to set up and maintain your interactive flat panel. It includes the following

information:

« How to mount yourinteractive flat panel

« How to connect your computer

« What users can do with your interactive flat panel

« How to maintain your interactive flat panel for years of use

« How to troubleshoot issues with your interactive flat panel

In addition, this guide includes information on your interactive flat panel’s on-screen display menu.
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This guide is intended for individuals who are responsible for installing and maintaining interactive
flat panels in their organizations. Other documentation and resources are available for individuals
who use interactive flat panels.

Other documentation and resources

In addition to this guide, there are resources for individuals who install, maintain and use interactive
flat panels.

Specifications

Your interactive flat panel’s specifications define the product’s dimensions, weight, recommended
operating and storage temperatures, power requirements and consumption and other important
information for installation and maintenance.

Model Specifications

SPNL-6065 smarttech.com/kb/170640

Installation instructions
Your interactive flat panel comes with installation instructions. These installation instructions explain
how to unpack, assemble and mount your interactive flat panel and how to connect it to computers
and other devices. If you misplaced these installation instructions, you can download a PDF version
from smarttech.com/kb/170641.

To use your interactive flat panel with a connected computer, you need to install SMART software
onthe computer (see SMART software on page 3).

Training
The SMART training website (smarttech.com/training) includes an extensive library of training
resources you can refer to when first learning to set up or use your interactive flat panel.

Knowledge base

The Support center (smarttech.com/support) includes a knowledge base that you can referto
when performing maintenance on your interactive flat panel or troubleshooting issues with your
interactive flat panel.
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Chapter 2

Mounting your interactive flat panel

Before mounting your interactive flat panel ... ... 9
Choosing @ loCation ... . 10
Choosing a height

To mount your interactive flat panel on a wall, you require a team of professional installers.

This chapteris intended for installers. Installers should read this chapter along with the installation
instructions included with the interactive flat panel before they mount the interactive flat panel.

FN WARNING

Improper mounting of your interactive flat panel can result in personal injury and product
damage.

Before mounting your interactive flat panel

Do the following before mounting your interactive flat panel:

« Review the environmental requirements in the interactive flat panel’s specifications (see
Specifications on page 7).

« Save all product packaging so that it’s available if you need to transport the interactive flat
panel. If the original packaging isn’t available, you can purchase new product packaging from
your authorized SMART reseller (smarttech.com/where).

« Referto local building codes to ensure the wall can support the weight of the interactive flat
panel and mounting equipment.

Model Weight (Ib.) Weight (kg)

SPNL-6065 136 61.4
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CHAPTER2
MOUNTING YOUR INTERACTIVE FLAT PANEL

Use a standard VESA mounting plate (not included) to mount the interactive flat panel on a

wall.
Model Mounting plate
SPNL-6065 400 mm x 400 mm

Use M8 screws to fasten the wall bracket.

Model Screw len gth1 Fasten force

SPNL-6065 20 mm +x mm < M8 <50 mm +xmm 97.36-177.01in-Ib.
(11-20 N-m)

ﬂ CAUTION

Do not over-tighten the
Screws.

NOTE

SMART recommends M8 x 30 mm mounting screws for standard installations where the
total wall mount bracket and washer thickness is less than 7 mm.

Because the receptacles might not be easily accessible after the installers mount the
interactive flat panel, consider connecting cables for power, computers and other devices
while the interactive flat panel is still in its packaging (see Connecting power and devices on
page 13).

Before turning on the interactive flat panel for the first time, clean the camera windows and
reflective tape following the instructions in Cleaning the camera windows and reflective tape
on page 27.

Choosing a location

Do the following when choosing a location for the interactive flat panel:

Do notinstall the interactive flat panel in a location where a door or gate could hit it.

Do notinstall the interactive flat panel in an area where it will be subjected to strong vibrations
ordust.

Do notinstall the interactive flat panel near where the main power supply enters the building.

Where x is the total thickness of the wall bracket and washer.

10
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CHAPTER2
MOUNTING YOUR INTERACTIVE FLAT PANEL

« Ensure adequate ventilation or provide air conditioning around the interactive flat panel so
that heat can flow away from the unit and the mounting equipment.

« If youmount the interactive flat panel in a recessed area, leave at least 4" (10 cm) of space
between the interactive flat panel and the recessed walls to enable ventilation and cooling.

Choosing a height
Consider the general height of the user community

when you choose the height for the interactive flat
panel.

)

]
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Chapter 3

Connecting power and devices

CONNE IO PANEIS e 13
CoNNECHING POW BT il 14
Connecting the CoOmMpPULEr .. 14
Connecting external SPeaKerS ... 15

This chapterincludes information on connecting your interactive flat panel to power, computers
and other devices.

Connector panels

There are connector panels on the left of your interactive flat panel.

The following diagram and table present the connectors on SMART Board 6065 interactive flat
panels:

[ LN
i ’ 3
o g .

) _ o i;ﬂ; 5+—4
y ' e e — nl

S <Ll

u l 5

]_'
No. Type Details Identifier
Left connector panel
1 Service port For SMART use
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CONNECTING POWER AND DEVICES

No. Type

Details Identifier

Left connector panel

2 Audio out Stereo 3.5 mm connector
3 USB USB 2.0 Type-Breceptacle
4 Video in HDMI connector HDMI

Back of the interactive flat panel

5 AC power

AC powerinlet and switch

NOTE

The HDMI cable should be HDMI 1.4 compliant and no longer than 16' 5" (5 m).

Connecting power

Connect the supplied power cable from the AC power inlet on the bottom of the interactive flat

panel to a power outlet. Turn on the main power switch.

NOTE

Refer to your interactive flat panel’s specifications for power requirements and power

consumption information (see Specifications on page 7).

Connecting the computer

NOTES

o The interactive flat panel can be used with a maximum of two USB-XT extenders.
o Ifusing a CAT 5 USB extender, the maximum length of Cat 5 cable is 52' (16 m).

14 smarttech.com/kb/170642



CHAPTER3
CONNECTING POWER AND DEVICES

Using the USB and HDMI cables, connect the computer to the USB receptacle and the HDMI
connector on the left connector panel, which is located on the back of your interactive flat panel.

=1

Connecting external speakers

Your interactive flat panel has two 10 W speakers on the left and right sides. You can connect

external speakers using the stereo 3.5 mm connector on the left connector panel.
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Chapter 4
Setting up your interactive flat panel
and computer

Turning on your interactive flat panel and computer for the firsttime ... ... ... ... . ......... 17
Installing SMART SOftWare .. il 17

Downloading and installing SMART software ... ... ... . 18
Running the connection Wizard .. . 18

This chapter explains how to set up your interactive flat panel and computer after mounting your
interactive flat panel and connecting power and devices.

Turning on your interactive flat panel and
computer for the first time

After connecting your computer to the interactive flat panel (see Connecting the computer on
page 14) and mounting the interactive flat panel (see Mounting your interactive flat panel on
page 9), you canturn on both devices.

To turn on your interactive flat panel and computer for the first time
1. Turn onyour computer.

2. Turnonyourinteractive flat panel by flicking the power switch beside the AC power inlet.

3. Pressthe Standby button v) on the front control panel.

Installing SMART software

To take full advantage of your interactive flat panel’s features, you must download and install
SMART software on your computer.

With the purchase of your interactive flat panel, you get a license for SMART Notebook software
and a one-year subscription to the SMART Notebook Advantage software maintenance plan. See
smarttech.com/notebook for more information.
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CHAPTER4
SETTING UP YOUR INTERACTIVE FLAT PANEL AND COMPUTER

Downloading and installing SMART software

TIP

You can also install SMART Notebook software from the DVD included with your interactive flat

panel.

. To download and install SMART software

1.

2.

Go to smarttech.com/downloads.

Scroll to the SMART Notebook software section.

Click Choose a version, and then select the most recent version.

Click Download.

Follow the on-screen instructions to save the installer to a temporary location.
Double-click the installer.

Follow the on-screen instructions to install SMART software.

Running the connection wizard

After turning on your interactive flat panel and computer for the first time and installing SMART

software, run the connection wizard to orient the interactive flat panel.

. To run the connection wizard

1.

18

Access the SMART Connection Wizard by opening SMART Settings (see Opening
SMART Settings on page 23).

Press Connection Wizard.
The SMART Connection Wizard appears.

Select the interactive flat panel from the list of connected SMART interactive products, and
then press Next.

Select Product is being set up for the first time, and then press Next.

Follow the on-screen instructions to orient the interactive flat panel for the first time.
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Chapter 5

Using your interactive flat panel

Turning on and turning off your interactive flat panel ... ... . ... 19
Resetting your interactive flat panel ... . ... 20
Using your interactive flat panel with the computer . ... 20
Using SMART SOftWare ... L 20
Menu CoNtrol Panel ... e 21
USING Pen ID 21
Changing the pen settings ... o . 21
Restoring pento default settings ... ... 22
Erasing onthe interactive flat panel .. ... 22

This chapter explains how to use the key features of your interactive flat panel.

Turning on and turning off your
interactive flat panel

You can turn on and turn off your interactive flat panel using the front control panel.

. To turn on your interactive flat panel

1. Turn onyour computer.
2. Pressthe Standby button J on the front control panel.
Your computer’s logon screen or desktop appears on your interactive flat panel.

IMPORTANT

If the Standby button ) is not amber, either the interactive flat panel is not plugged in or
the main power switch on the bottom connector panel is turned off. To find the main power
switch, see Connector panels on page 13.
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USING YOUR INTERACTIVE FLAT PANEL

. To turn off your interactive flat panel

1. Turn off your computer.

2. Pressthe Standby button J on the front control panel twice.

Resetting your interactive flat panel

You can reset your interactive flat panel using the front control panel.

. To reset your interactive flat panel

1. Press the Standby button J on the front control panel.

2. Pressand hold the Standby button J until the screen turns black.

The interactive flat panel resets and then your computer’s logon screen or desktop appears

onyourinteractive flat panel.

Using your interactive flat panel with
the computer

Users will most often use the interactive flat panel with the computer you set up in the previous
chapter (see Setting up your interactive flat panel and computer on page 17).

Using SMART software

The SMART software installed on the computer allows users to do the following:
« Interact with objects on the screen by touching them
« Write, draw and erase digital ink

« Use multitouch gestures to browse pages, zoom in and out, and resize, rotate, group, ungroup

and flick objects

20 smarttech.com/kb/170642
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Menu control panel

You can navigate the on-screen display menu with the menu control panel located on the left of
your interactive flat panel. For more information on the on-screen display menu, see
SMART Board 6065 interactive flat panel on-screen display menu on page 40.

No. Name

> 1 MENU

SET

[Down]

[Left]
[Up]
[Right]

] &.me

IR0

Ol || wWw|N

Using Pen ID

The SMART Board 6065 interactive flat panel has Pen ID. Pen ID allows you to change the settings
for each penindependently. The black pen defaults to black ink and the red pen defaults to red
ink.

The colorring on the pen identifies the color of the default ink.

Color ring

Changing the pen settings

You can change your pen settings, including line size and fill effects.
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USING YOUR INTERACTIVE FLAT PANEL

. To changethe pen settings

1. Openthe SMART Ink toolbar or the SMART Notebook Pens toolbar.

2. Using your pen, change the pen settings.

Restoring pen to default settings
You can restore the pens to their default settings by returning them to the pen tray.

Erasing on the interactive flat panel

To erase content on the interactive flat panel

¢ use the erasers on the back of the pens
« Use the erasing gesture (the palm or fist)

o use the software’s Erasertool
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If you properly maintain your interactive flat panel, it will provide years of use.

Opening SMART Settings

Several maintenance and troubleshooting procedures in this guide require you to open
SMART Settings.

. To open SMART Settings on Windows 7 operating systems
Select Start > All Programs > SMART Technologies > SMART Tools > SMART Settings.

SMART Settings appears.
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MAINTAINING YOUR INTERACTIVE FLAT PANEL

. To open SMART Settings on Windows 8 operating systems
1. Openthe Apps screen.
2. Press SMART Settings.

SMART Settings appears.

. To open SMART Settings on Mac OS operating system software

1. Pressthe SMART Board icon L § iin the Dock.

2. Press SMART Settings.

SMART Settings appears.

Updating firmware

Your interactive flat panel uses firmware on its processor. You can update the firmware. For more
information, see Upgrading the firmware on your SMART Board 6065 interactive flat panel.

Updating software

SMART Product Update (SPU) is included in the SMART software you installed to use your
interactive flat panel (see Installing SMART software on page 17). SPU periodically checks for
updates to the SMART software posted on the SMART website. You can configure SPU to prompt
users to install updates or to install updates automatically.

NOTE

If you didn’t install SPU, you can download updates to SMART software from
smarttech.com/downloads.

Orienting your interactive flat panel

If the location of your touch is misinterpreted (the pointer appears a distance from the actual
contact), orient your interactive flat panel.

NOTE

You can use your finger or an interactive flat panel pen to orient your interactive flat panel.
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CHAPTERG6
MAINTAINING YOUR INTERACTIVE FLAT PANEL

. To orient theinteractive flat panel

1.

2.

Open SMART Settings (see Opening SMART Settings on page 23).
Press Orient.

Press the red targets as they appear. Hold your finger or the tip of the pen at the center of
each target, and then lift the pen or finger. When you lift the pen or finger, the target moves to

the next orientation point.

IMPORTANT
Hold the pen perpendicular to the screen.
Continue until you've pressed all the targets.
The orientation window closes.

If this doesn’t correct inaccurate touch, calibrate your interactive flat panel (see Calibrating
your interactive flat panel below).

Calibrating your interactive flat panel

Digital cameras in the corners of the interactive flat panel track the position of the pens, eraser and
your finger on the interactive surface, and then send the information to the SMART software, which

interprets this information as mouse clicks, digital ink or ink removal in the appropriate location.

Calibration determines the position and angles of the cameras to accurately identify the location of

touches on your interactive flat panel.

IMPORTANT

If an error message appears while you are calibrating your interactive flat panel, contact

SMART Support (smarttech.com/contactsupport).

. To calibrate your interactive flat panel

1.

2.
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Open SMART Settings (see Opening SMART Settings on page 23).

Press SMART Hardware Settings.

If you have more than one SMART product connected, select the interactive flat panel.
Select Advanced Settings from the drop-down list.

Press Calibrate.

The calibration screen appears. This can take a few moments.
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TAINING YOUR INTERACTIVE FLAT PANEL

Press the red target with the tip of an interactive flat panel pen. Hold the tip at the center of
the target until the target turns green, and then lift the pen.

The target moves to the next location.
NOTE
You can calibrate a target again by pressing the LEFT ARROW key on your keyboard.

Continue pressing targets until the second calibration screen and a grid appears.

An example appears briefly to demonstrate how to draw across the screen to calibrate the
interactive surface.

Use a pento draw a spiral horizontally across the grid. As you draw, the ink is blue. As you
complete each square, the square becomes green.

When all the squares are green, a progress bar appears.

When the progress bar is full, the interactive flat panel displays the message Calibration
successful.

Orient your interactive flat panel (see Orienting your interactive flat panel on page 24).

Replacing a pen nib

Top

revent damage to your interactive flat panel’s anti-glare coating, replace your pen nib if it

becomes worn. You can purchase replacements from your authorized SMART reseller

(sma

rttech.com/where).

. To replace a pen nib

1.

2.

Grasp the worn nib on your pen with a pair of pliers, and then pull and twist the nib loose.

Press the replacement nib into the pen.

Cleaning the screen

Follow these instructions to clean the interactive flat panel screen without damaging its anti-glare

coating or other product components.

Al
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CAUTION

Do not use permanent or dry-erase markers on the screen. If dry-erase markers are used on
the screen, remove the ink as soon as possible with a lint-free, non-abrasive cloth.

Do not rub the screen with a dense or rough material.
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« Do not apply pressure to the screen.

« Do not use cleaning solution or glass cleaner on the interactive flat panel screen, because
they can deteriorate or discolor the screen.

« Avoid touching the reflective tape between the screen and the bezel, and ensure that this
strip stays dry. Damage to this strip affects touch interactivity.

. To clean the screen

1. Shut off your computer, and then disconnect the power sources for your computer and your
interactive flat panel.

2. Wipe the screen with a lint-free, non-abrasive cloth.

Cleaning the camera windows and reflective tape

The DVIT technology in your interactive flat panel uses four cameras in the corners of the frame
and the reflective material between the screen and the bezels. Excessive dust buildup on the
camera windows or reflective tape can impair touch performance.

These areas should be inspected regularly for dust and should be cleaned if any obvious dust
buildup has occurred.

'Y cauTioN

o Do not use compressed air to clean the camera windows or borders.
« Do not use water, chemicals or cleaning agents.

« Applying too much pressure when cleaning the tape or cameras can damage the tape and

cause performance issues or errors.

. To clean the camera windows and reflective tape

1. With a clean lint-free cloth, gently wipe the camera windows in the top corners and the
reflective tape along the top of your interactive flat panel screen using the cloth.

2. Gently wipe the reflective tape along the sides of your interactive flat panel screen.

3. Gently wipe the camera windows in the bottom corners and the reflective strip across the
bottom of your interactive flat panel screen.
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Maintaining ventilation

Your interactive flat panel requires ventilation to enable the cooling fans to function. Dust buildup in

the ventilation holes compromises cooling and leads to product failure.

Clean accessible ventilation holes monthly with a dry cloth.

Use a vacuum cleaner with a narrow hose end fitting to clear the back ventilation holes
regularly. You might have to remove the interactive flat panel from your wall. For more
information on removing your interactive flat panel see Removing your interactive flat panel
on the next page.

' cauTtioN

Avoid setting up or using your interactive flat panel in an area with excessive levels of dust,

humidity or smoke.

Preventing condensation

Your interactive flat panel screen contains layers of glass that can collect condensation, especially

in the following conditions:

Temperature extremes with high humidity

Rapid changes in humidity, which can occur when you operate the product near water, such as
a sink, pool, kettle or air conditioner ventilator

Direct exposure to sunlight

. To evaporate condensation from your interactive flat panel

1.

2.
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Remove the humidity source from the interactive flat panel, if possible.

Adjust the room temperature to normal operating ranges. See the SMART Board 6065
interactive flat panel specifications (smarttech.com/kb/170640) for more information on
normal operating ranges .

Turn on the interactive flat panel and leave it on for 2—3 hours.

If the screen condensation doesn’t evaporate, contact SMART Support

(smarttech.com/contactsupport).

smarttech.com/kb/170642


http://www.smarttech.com/kb/170640
http://www.smarttech.com/contactsupport

CHAPTERG6
MAINTAINING YOUR INTERACTIVE FLAT PANEL

Checking the interactive flat panel installation

Inspect your interactive flat panel installation frequently to ensure that it remains securely installed.
« Check the mounting location for signs of damage or weakness that can occur over time.
« Check forloose screws, gaps, distortions or other issues that could occur with the mounting

apparatus.

If you find an issue, contact a professional installer.

Removing your interactive flat panel

To safely remove your interactive flat panel, use two or more professional installers.

PN WARNING

« Do not attempt to move the interactive flat panel using your own strength. The interactive
flat panel is very heavy.

« Do not move the interactive flat panel by connecting a rope or wire to the handles on the
back. The interactive flat panel can fall and cause personal injury and product damage.

IMPORTANT

Follow the instructions included with the floor stand or mounting apparatus.

. To remove your interactive flat panel
1. Turn off your interactive flat panel and disconnect the power cable from the wall outlet.
2. Remove all accessible cables and connectors.
3. Lift yourinteractive flat panel from its mounting location.

PN WARNING

Do not place the interactive flat panel on a sloping or unstable cart, stand or table, because
the interactive flat panel could fall, resulting in injury and severe product damage.

7' cauTioN

Do not leave the interactive flat panel face up, face down or upside down for an extended
period of time, because it could cause permanent damage to the screen.
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Transporting your interactive flat panel

Save your original packaging so that you can repack your interactive flat panel with as much of the
original packaging as possible. This packaging was designed with optimal shock and vibration
protection. If your original packaging isn’t available, you can purchase the same packaging directly
from your authorized SMART reseller (smarttech.com/where).

'Y cauTioN

Transport your interactive flat panel only in original or replaced packaging. Transporting your
interactive flat panel without correct packaging voids your warranty and could lead to product
damage.
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This chapter provides you with the information necessary to solve simple issues that can occur with
your interactive flat panel. If issues persist, or aren’t covered in this chapter, contact
SMART Support (smarttech.com/contactsupport).

Locating the interactive flat panel serial number

When you contact SMART Support, you might be asked to provide the interactive flat panel serial
number. The easiest way to locate this serial number is using the on-screen display menu (see
page 42).

Resolving image issues

Complete the following steps if your interactive flat panel doesn’t display an image correctly or
doesn’t display any image at all.
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Resolving blank screenissues
Use the following troubleshooting table when your computer is turned on but you don’t see an

image on the interactive flat panel screen.

Begin by looking at the front control panel light.

Front control | Causes Solution
panel light
Off The interactive flat panel isn’t Connect your interactive flat panel’s power
connected to a power source. cable to a power outlet (see page 14).
The main power is off. Flick the power switch to turn the main
power on (see page 13).
Amber The interactive flat panelis in Press the Standby button D on the front

Standby mode.

control panel.

Resolving image quality issues

Symptom

Causes

Solution

The image is too large, too

small ordoesn’t

completely fill the screen.

The computer’s video

« The native resolutionis

resolution settings don’t 3840 x 2160 at 30 Hz.
matCh yourinteractive ﬂat . |fyour Computercan’t Support
panel’s native resolution. the above resolution, consider

1920 x 1080 at 60 Hz as an
alternative.
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Symptom

Causes

Solution

The screenresolution is
correct, but the image is
surrounded by black bars.

The computer’s video card
is underscanning the
image.

o Turn off or adjust the
overscan/underscan feature in
the video card driver software
until the image fits the screen
resolution. Referto your
computer’s video card Help for
more information.

« Selectthe 4K UHD option from
your video card driver’s
advanced menu (if available).
This should provide a pixel-
perfectimage foryour
interactive flat panel.

You have a poor quality
video cable.

Replace your video cable with a
better quality video cable.

You connected two video
cablestogether.

Replace yourtwo cables with one
longer cable.

OR
Move your computer so that it’s

within a single cable length of your
interactive flat panel.

The interactive flat panel’s
native resolution doesn’t
match the resolution on
your computer’s display
adapter.

Check the resolution on your
computer’s display adapter and
change the interactive flat panel’s
resolution to match.
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Symptom

Causes

Solution

The image is unstable or
unfocused.

The video connectionis
loose.

Secure the video cable to both your
computer and your interactive flat
panel.

You have a poor quality
video cable.

Replace yourvideo cable with a
better quality video cable.

You connected two video
cablestogether.

Replace your two cables with one
longer cable.

OR

Move your computer so that it’s
within a single cable length of your
interactive flat panel.

Your computer’'s video
display card is defective.

Connect a different computer to your
interactive flat panel. If this improves
the image quality, consider replacing
the video card in the original
computer.

The image is too light, too
dark or has poorimage
quality.

You might have incorrect
video settings.

Adjust the Picture options (see
Picture on page 40).

There is a persistent image
onthe screen.

Animage was displayed
fortoo long.

« Turn off yourinteractive flat
panel and leave it turned off for
as long as the image was on the
screen.

« Use ascreensaverto prevent
persistent images.

Other display quality issues

Return all on-screen display menu
settings to their default values (see
page 42).
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Resolving touch control and digital ink issues

Use the following troubleshooting table if you can see your computer desktop on your interactive

flat panel, but you don’t have touch control over the desktop.

panelisn’t
oriented.

Symptom | Causes Solution
Whenyou |SMART Product Dri | Update SMART Product Drivers (see page 24).
touch the vers isn’t current.
screen, no
pointer
appears There’s no USB Verify your connections (see page 14).
and you're |connectionfrom
unable to the computerto
move the interactive flat
icons. panel.
The SMART Product Dri | Download and install SMART Product Drivers from
SMART Bo |versisn'tinstalled. |smarttech.com/downloads.
ard icon
Lj SMART Product Dri | Start SMART Board Tools following the steps in the Help (see
doesn’t versisn'trunning. | page 7).
appear.
Touch Your computeris Close some open applications.
interactivit | running too many
y is slow. applications.
Your computer Upgrade your computer or replace it with another computer
doesn't meet that meets system requirements.
system
requirements.
You haven'tused a | Use a USB 2.0 cable and ensure it’s connected to the USB
USB 2.0 cable to receptacle.
connect your
interactive flat
panel to your
computer.
Whenyou |You arenttouching | For more information, see Touching and drawing on your
touch the the screenata SMART Board interactive whiteboard is inaccurate (
screen, the |right angle. http://knowledgebase.force.com/articles/TROUBLESHOOTIN
pointer G/Touching-and-drawing-on-your-SMART-Board-interactive-
appearsin whiteboard-is-inaccurate-1378705217746).
the wrong ) ) - ; ;
location. Your interactive flat | Orient your interactive flat panel (see page 24.)
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Symptom | Causes Solution

Anarea of |Somethingis Ensure nothing is taped to the screen.

the screen |blocking the

doesn’t cameras.

respond to T - -

your touch Something is on Remove items from the reflective tape channel.
the reflective tape

or when
channel.

you draw

digitalink, | Yourfingerorpen |Use consistent pressure while drawing digital ink.
the lines is skipping as you
are broken. | draw. This is most
common on the

upstroke.

Bright lights are Close blinds or shades or dim all halogen lights and LEDs.
interfering with the

cameras.

Your cameras Calibrate your interactive flat panel (see page 25).

require calibration,
possibly because
of atemperature
change in the
room.

Resolving audio issues

IMPORTANT

Ensure that you can see your computer’s desktop and that you have touch control and digital ink
before using this table. If not, resolve those issues before completing the steps in the table

below.
Symptom Causes Solution
Sound doesn’t play when Your computer is muted. Turn off the mute setting.

you play a sound file. ; )
Your computer’s volume is | Turn up the volume onyour

too low. computer.

Your interactive flat panel is | Turn off the mute setting using the
muted. front control panel.

Your interactive flat panel’s | Turn the volume up using the front
volume is too low. control panel.
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Resolving issues using the SMART
Connection Wizard

You can resolve a variety of issues using the SMART Connection Wizard found in SMART Settings.

. To resolve issues using the SMART Connection Wizard

1. Access the SMART Connection Wizard by opening SMART Settings (see Opening
SMART Settings on page 23).

2. Press Connection Wizard.
The SMART Connection Wizard appears.
3. Select SMART Board 6065 series interactive flat panel, and then press Next.

4. Selectthe option that best describes the issue you’re encountering, and follow the on-screen
instructions to troubleshoot your interactive flat panel.

Resolving issues using SMART Board Diagnostics

If you touch the interactive flat panel’s surface and nothing happens, or if there is no digital ink or
the ink appears in some locations and not in others, use SMART Board Diagnostics to help identify
and resolve these issues.

IMPORTANT
Do not change diagnostic settings unless asked to do so by SMART Support.

Checking the camera view
If nothing happens when you touch the interactive flat panel’s surface, check to make sure that
nothing is blocking one of the cameras.

. To check camera views
1. Open SMART Settings (see Opening SMART Settings on page 23).
2. Select About Software and Product Support > Tools > Diaghostics.
SMART Board Diagnostics opens.
3. Select View>SMART Board 6065 Bar.

The group box appears.
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4.

38

Press View.
The camera view screen appears.
Click Get image to display the four camera views. This could take a few moments.

If one of the camera views doesn’t appear, the camera is blocked or can’t locate the
reflective tape on the interactive flat panel’s inner frame.

NOTE

You can compare the camera view to examples of normal camera views.

Check the camera lens and ensure that nothing is blocking its view and that nothing is affixed

to the interactive surface.
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You can access the on-screen display menu using the menu control panel (see Menu control panel
on page 21).

Changing settings in the on-screen display menu

. To change settings in the on-screen display menu
1. Press the MENU button on the menu control panel.
The on-screen display menu appears.
2. Pressthe up and down arrows to select a menu, and then press SET.
3. Pressthe up and down arrows to select a menu option.
4. Pressthe left and right arrows to change the menu option’s setting.
OR

Press the right arrow to open the menu option’s submenu. (Repeat steps 3 and 4 to change
settings in the submenu.)

5. Press MENU until the on-screen menu closes.
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SMART Board 6065 interactive flat panel
on-screen display menu

Option Values Function Notes (if any)
Picture
» Picture Mode Standard Sets the picture mode Select User to customize
User brightness, contrast, sharpness
. and other Picture options.

Dynamic
Select one of this option’s other
values to set brightness, contrast,
sharpness and other Picture
options to default values.

® Brightness 0-100 Sets the overall brightness of the You can modify this option only if
image and background you select User in Picture Mode.

® Contrast 0-100 Sets the brightness of theimagein | You can modify this option only if
relation to the background you select User in Picture Mode.

® BlackLevel 0-100 Sets the level of brightness in the You can modify this option only if
darkest parts of the image you select User in Picture Mode.

® Color 0-100 Sets the image color depth You can modify this option only if
you select User in Picture Mode.

® Sharpness 0-100 Sets the image sharpness You can modify this option only if
you select User in Picture Mode.

> Color temperature Normal Sets the color temperature Select User to customize the

Warm amountofred, green andblue in

User the image.

Cool Select one of this option’s other
values to setthe amount of red,
green and blue in the image to
default values.

® Red 0-100 Sets the amount of red in the You can modify this option only if
image you select User in Color
Temperature.
® Green 0-100 Sets the amount of greenin the You can modify this option only if
image you selectUser in Color
Temperature.
® Blue 0-100 Sets the amount of blue in the You can modify this option only if
image you select User in Color
Temperature.
® Movie Mode Off Sets the brightness, contrast, black

Low level, color and sharpness for

Middle movie watching

High

® Picture Reset [N/A] Resets all options in the Picture

menu to their default values
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Option Values Function Notes (if any)
Sound
» SoundMode
® Treble L50-R50 Sets the high frequency sound
® Bass L50-R50 Sets the low frequency sound
> EQ
® 120 Hz 0-100 Sets the sound equalization at 120
Hz
® 500 Hz 0-100 Sets the sound equalization at 500
Hz
® 1.2kHz 0-100 Sets the sound equalization at1.5
kHz
® 75kHz 0-100 Sets the sound equalization at
5kHz
® 12kHz 0-100 Sets the sound equalization at 10
kHz
® Balance L50-R50 Balances the left and right volume
® Audio Input USB Sets the audio input source
HDMI
® SoundReset [N/A] Resets all options in the Sound
menu to their default values
OosD
® language [Languages] Sets the on-screen display menu’s
language
® OSD Turn Off Off Sets the time of inactivity before the
5seconds on-screen display menu turns off
10 seconds (in seconds)
15 seconds
® OSDReset [N/A] Resets all options in the OSD menu
to their default values
Setup
® Power Save On Enables or disables Power Save When Power Save mode is enabled
Off mode and there isn’tvideo input, the

interactive flat panel displays
No Signal for 25 seconds before
turning off.

Don’t change this option from its
default value.

® Setup Reset

Restores the setup settings to their
defaultvalue
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Option Values Function Notes (if any)

® Factory Reset Resets options in allmenus to their
default values

About

® ModelNumber Displays the interactive flat panel’s
model number

® Serial Number Displays the interactive flat panel’s
serialnumber

® Scalar firmware version Displays the interactive flat panel's
scalar frmware version

® Touch firmware version Displays the interactive flat panel's
touch firmware version

® OPSInformation Displays whether the OPS is
installed
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Hardware environmental
compliance

SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,
sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment (WEEE)
Electrical and electronic equipment contain substances that can be harmful to the

environment and to human health. The crossed-out wheeled bin symbol indicates that E
products should be disposed of in the appropriate recycling stream and not as regular

waste.

More information

See smarttech.com/compliance for more information.
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